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Change log

Change log

Date Change Description

8-12-2022 Initial release.

9-2-2022 Removed Known Issues: 710416, 677628, 675180, 646580, 610581, 609976, 609046,
522468, 812674, 812581, 814631, 815352, 816871, 828242

9-2-2022 Removed and moving to Administration Guide:
l Removing a device from the L2Wired Devices or L2 Wireless Devices Group
does not disable L2 (Hosts) Polling under the Polling tab in Topology.

l The "Set all hosts 'Risk State' to 'Safe'" button changes the status of all hosts
marked At-Risk to Safe. However, the status of the individual scans for each host
remain unchanged.

l System > Settings > Updates > Operating System will only record and display
dates of OS updates that are completed through the Administrative UI. If
Operating System updates are run via command line using the "yum" tool, the
update is not recorded. Resolution: Execute Operating System Updates through
the Administrative UI in order to maintain update history.

9-2-2022 Added Known Issues: 830581, 830932, 832313, 833305, 834461, 835143, 835149,
835405, 836137, 836146, 836435, 836606

9-2-2022 Removed Device Consideration: At this time, integration with Ubiquiti AirOS AP is not
supported. Ubiquiti AirOS AP does not have the necessary capabilities to allow for full
integration with FortiNAC. The limitations are as follows: - No support for external MAC
Authentication using RADIUS. - Limited CLI and SNMP capability. No ability to
dynamically modify access parameters (ie. VLANs) for active sessions.

9-2-2022 Added ID 695435 to Known Issue "FortiEDR is currently not supported. If required,
contact sales or open a support ticket to submit a New Feature Request (NFR)."

10-3-2022 Added Known Issues: 845003, 845000, 842370, 842280, 842112, 841907, 840796,
838525, 835782, 833735, 833327
Added Device Support Considerations: 843509, 842181, 836831

10-18-2022 Changed Known Issue: 842112 to 842122.
Added Known Issues: 699106, 834094/834089/845493/845505, 845412, 845930,
848274, 849140, 849497
Added Device Support Considerations: 829009, 846782
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Overview

Overview

Version 9.2.6 is the latest release being made available to customers to provide functionality and address some
known issues.

Important

l 9.1.0+ uses a new GUI format. FortiNAC cannot go backwards to a previous version. Snapshots should
always be taken on virtual appliances prior to upgrade.

l Prior to upgrade, review the FortiNAC Known Anomalies posted in the Fortinet Document Library.
l If using agents or configured for High Availability, additional steps may be required after upgrade for proper
functionality. See Upgrade Instructions and Considerations posted in the Fortinet Document Library.

l Requires CentOS 7.4 or higher. The current CentOS version installed is listed as "Distribution" in the CLI
login banner or typing "sysinfo".
Example:
> sysinfo
************************************************************************
Recognized platform: Linux
Distribution: CentOS Linux release 7.6.1810 (Core)
If the CentOS version is below 7.4, run OS updates and reboot before upgrading. For instructions on
updating CentOS, refer to the Fortinet Document Library.

l For upgrade procedure, see Upgrade Instructions and Considerations posted in the Fortinet Document
Library.

Supplemental Documentation

The following can be found in the Fortinet Document Library.

l FortiNAC Release Matrix

Version Information

These Release Notes contain additional Enhancements, Device Support, and features. Unique numbering is
used for the various components of the product. The software version and Agent version supplied with this
release are listed below.

Version: 9.2.6

Agent Version: 5.3.0.77

A newer Persistent Agent may be required to support certain antivirus and anti-spyware products. Refer to the
Agent Release Notes in the Fortinet Document Library.
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Overview

Firmware version represents a collection of system services and operating system features imaged on to the
appliance before it leaves manufacturing. The firmware image cannot be updated by a Fortinet customer.
Services within the image are updated by Fortinet or a certified Fortinet Partner in appliance maintenance
packages released as new more robust and secure versions of services become available.

Note that upgrading software versions does not change firmware nor does it automatically require an upgrade to
the Persistent Agent. Newer Persistent Agents are not compatible with older software versions unless that
capability is specifically highlighted in the corresponding release notes.
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Compatibility

Compatibility

FortiNAC Product releases are not backwards compatible. It is not possible to go from a newer release to any
older release.

Example: 8.1.1.132 cannot be downgraded to any other release.

To backup the current system prior to upgrade on virtual machines, perform a snapshot. For physical
appliances refer to the document Back Up and Restore an Image of a FortiNAC Appliance.

Agents

FortiNAC Agent Package releases 5.x are compatible with FortiNAC Product release 9.x. Compatibility of Agent
Package versions 4.x and below with FortiNAC versions 8.x and greater are not guaranteed.

Web Browsers for the Administration UI

Many of the views in FortiNAC are highly dependent on JavaScript. The browser used directly impacts the
performance of these views. It is recommended that you choose a browser with enhanced JavaScript
processing.

Operating Systems Supported Without an Agent

Android Apple iOS Blackberry OS BlackBerry 10 OS

Chrome OS Free BSD Kindle Kindle Fire

iOS for iPad iOS for iPhone iOS for iPod Linux

Mac OS X Open BSD Net BSD RIM Tablet OS

Solaris Symian Web OS Windows

Windows CE Windows Phone Windows RT
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New Features

New Features

New Features in 9.2.6 8

New Features in 9.2.5 8

New Features in 9.2.4 8

New Features in 9.2.3 8

New Features in 9.2.2 8

New Features in 9.2.1 9

New Features in 9.2.0 9

New Features in 9.2.6

There are no new features in version 9.2.6.0451.

New Features in 9.2.5

There are no new features in version 9.2.5.0443.

New Features in 9.2.4

There are no new features in version 9.2.4.0438.

New Features in 9.2.3

There are no new features in version 9.2.3.0435.

New Features in 9.2.2

There are no new features in version 9.2.2.0421.
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New Features

New Features in 9.2.1

There are no new features in version 9.2.1.0414.

New Features in 9.2.0

l Enhanced Appliance Installation: Login to the Administration UI in order to apply license key, configure
appliance network settings and the FortiNAC Service Interface (eth1). There is no longer a separate UI.

l Ability to add Custom Endpoint Fingerprints using the REST API.
l New Endpoint Fingerprints view (Replaces Device Identity view) and Tasks view.
l Local RADIUS Server Enhancements

o Updated views including configuration subsections
o Multiple virtual Local RADIUS Servers
o Multiple Winbind instances
o Improved debugging tools
o Improved visibility of services and configuration
o Added support for EAP-FAST in FreeRADIUS to the extent possible:
Configurable EAP-FAST controls:
n PAC Opaque Key
n Allow Anonymous In-Band PAC Provisioning
n Allow Authenticated In-Band PAC Provisioning

l Dashboard Rework
l Multiplicity - Multiple Dashboards may now be created and the name may be freely modified.
Dashboards may have multiple instances of each Widget.

l Layout and Sizing - Widgets (formerly known as panels) are rendered in a row with a number of
columns available based on the screen size. The row wraps automatically, filling from the left. All
Widgets have a fixed height, but user adjustable width set to the number of columns they should span.

l New Tiles for Pending Tasks and Endpoint Fingerprints.
l Persistent Agent Enhancements (Agent 5.3)

o Agent included in FortiNAC 9.2
o Agent fingerprints are now visible in the Endpoint fingerprints view
o See 5.3 Agent Release notes for details and other enhancements

l FSSO Enhancements
o User definable network address objects and address groups for SSOmessaging.
o Support for managing hosts with PA installed but not seen as connected by FortiNAC by a managed
device.

o Support for new dynamic firewall address API that will replace the FSSO protocol in FGTs running
FOS 7.0.2

l Netflow protocol support added for Device Profiling..

FortiNAC 9.2.6 Release Notes 9
Fortinet Inc.



Enhancements and Addressed Issues

Enhancements and Addressed Issues

These changes have been made in FortiNAC Version 9.2. These enhancements are in addition to the
enhancements that are outlined in previous releases.

Version 9.2.6

Ticket # Description (9.2.6.0451)

806106 Juniper Change of Authorization (CoA) Fails.

701822 Fully Qualified Host Name info Bubble is misleading.

773088 VLAN read failure for Adtran NetVanta 1638.

775679 Hosts are incorrectly enabled after an LDAP sync.

784543 Portal policy permission set is required to send guest email details from
Guests and Contractors view.Otherwise, 403 error is thrown.

785791 Fortigate cluster not modeled completely.

789654 Clients shown offline in Ruckus controller v6.0.

791889 Audit Logs do not report the Adds from a Host Import.

795932 RADIUS authentication fails when primary LDAP directory is down.

799401 SNMPMAC-Notification trap support for Dell EMC Networking N3248P-
ON.

802969 Account Requests view has incorrect or missing sort keys.

803314 ConfigWizard does not correctly update hostname in /etc/hosts.

803382 Audit Log service does not use the Audit Log permissions.

804759 In Users & Hosts > User Accounts, clearing a value in the search box and
clicking enter results in several empty rows.

806936 Importing Mist APs with CLI import tool does not add the AP models to the
L2Wireless nor Device Interface Status groups.

810167 iOS fingerprints misclassified as macOS.

810209 SSIDs are not complete in UI for Aruba controller VIP.

811775 Performance improvements with client lookups.

812581 Duplicate user ID exceptions during RADIUS auth when userID does not
match the name in an email address.

812674 CoA is not being sent to Huawei wireless after host has registered.
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Enhancements and Addressed Issues

Ticket # Description (9.2.6.0451)

812908 /var/log/messages is not rotating,generating large files and high disk usage.

812933 L2 poll not working for HP NJ5000-5G-PoE+Walljack.

813564 FortiNAC fails to find API port from FortiSwitch.

813654 Added support for FortiSwitch MAC Notification traps.

813681 Missing resource exception: SSOManager in output.master.

814631 Ports not properly configured using Aruba CLI scripts.FortiNAC reads Port
ID for the port variable instead of port number.

815352 Logical Network configuration mappings can return the wrong value when
host is connected via more than one interface.

816031 FSSO tag information is not sent to FortiGate.

816407 FortiGate L3 polling doesn't update the client IP.

816451 Importing DHCP Scopes - Wizard shows blank scope data.

816799 Fix TaskFilterSpecification startId and maxRows.

816871 System Update settings do not update on the Secondary Server in High
Availability environments.

816877 Host icon does not match the icon assigned by Device Profiling Rule.

817022 Hosts View - Rogue record Host Name is not updated from DHCP.

817767 CLI failure on Alaxala switch with enable password bypass configured.

817845 L2 Polling queue backed up, excessive polling completion times.

819384 Added DHCP fingerprint for Fortinet IP Phone.

819470 Fingerprints that can match Windows 2012 do not indicate Windows 2012.

819753 FSSO Tag assignment is not triggered before the next L3 poll.

820569 Policy - User Permissions: No Group Access causes Who/What Groups
andWhere Locations Select Entries panels to hang.

821244 Device Profiler failing to match Fortiguard method when Fortiguard polling
returns confidence values over 127.

821527 RADIUS does not start after upgrade from 9.4.0.0717 GA to 10.0.0.0013.

823908 Aruba switch device failed to connect using valid CLI credentials.

823955 Wireless clients connected to FortiAP show up in FNAC on wrong interface.

825436 IP addresses appended to network device names during discovery are
truncated. This can result in duplicate device and port names.

825467 WinRM Device Profiling Method doesnt handle multiple credentials
properly.
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Enhancements and Addressed Issues

Ticket # Description (9.2.6.0451)

825766 Adapters View - Status tooltip clips if it contains more than 2 rows of data.

825770 DOC API - FortiNAC_REST_Schema_9.2.pdf - "deviceID" required for -
policy/logical-network-configuration/element/properties.

825920 Ruckus SZ Controller:When NAS ID = Controller IP and the Source IP =
Access Point IP, RADIUS CoA fails unexpectedly.

826155 Updated OUIs.

826648 Wireless hosts are not displayed correctly in Meraki AP device port/adapter
view.

826924 Fixed integration for DGS-1510-28X Gigabit Ethernet SmartPro Switch.

828242 Ruckus Switch Non-Default VRF Arp entries no longer contained at
ipNetToMediaPhysAddress.

828912 MDM poll fails for MaaS360.

832965 COA Disconnect not working on Juniper EX.

833332 When an Admin user changes their own password, and error message
appears and they are immediately logged out.

833351 Guests: Cannot modify Guest - Invalid Password error.

833429 Config Wizard: Clicking Next or Back on any non-Basic Network page
returns user to Basic Network page.

833440 Config Wizard: Clicking Cancel in Add Scopes page gives 500 Internal
Server Error.

833700 RADIUS server fails to enable when upgrading from build 0721 to 0722.

834144 HTTP 500 error when entering license code.

834302 Updating NTP generates "Failed to save Time Config".

834479 When creating a new user via the REST API (and thus GUI), the password
was not hashed properly.

751468 , 811479 , 770730 RADIUS/Winbind services need manual startup to handle system reboot.

Version 9.2.5

Ticket # Description (9.2.5.0443)

726333 Entitlements (such as concurrent licenses) for Subscription Licenses are
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Enhancements and Addressed Issues

Ticket # Description (9.2.5.0443)

not accurately reflected in the Administration UI License Management view
and only show Base licenses.

733943 Changing password in bulk using Set Model Configuration sets the same
username for all selected devices

747921 Portal renaming does not rename the associated CSS files.

751393 UserManager NullPointerExceptions.

770974 Event Lifetime alarm trigger rule is not being honored when configured.

781520 RADIUS COA failing for FortiAP when hosts are deleted.

783587 AirWatch MDM roles are overwritten by user roles.

786651 Improved support for MICROSENS G6 Micro-Switch.

787271 Certificate Management View - Server Certs & Trusted Certs views both
showing results from both views.

789970 FortiNAC sends SSO login message to only one slot on the 6000 & 7000
FortiGate chassis.

791405 "Request unsuccessful with no errors reported" message opening Model
Configuration tab for HPEWalljack.

794067 Support for new "show clients" table format in version 8.X Aruba IAP
firmware.

794381 Fortigate forwarding class does not work with tlsv1.3.

795260 Motorola controllers proxying AP auth requests send Proxy-State attr and
expect it unchanged in response. RADIUS (local) does not send it back.

796065 Unable to set device profiling to Host to Logged in User (if Present) on
NCM.

796522 SocketTimeoutException in logs related to Telnet/SSH connections.

796533 Support for Physical Ethernet MAC for Apple TV in Jamf.

796623 MS Intune API only returns ethernetMacAddress per device.

797708 Force 10 switches sometimes modeled incorrectly.

797723 Local RADIUS mode:RADIUS fails for endpoints connecting to a
FortiSwitch that has been renamed.

798181 RADIUS Service Host MAC filter does not print debug if supplicant does not
use colon mac delimiter.

800408 API query for FLink FSW data deprecated in FOS 7.2+.Prevents
FortiSwitches in Link mode from being added to Inventory when the
managing FortiGate is discovered.

801252 RADIUS not mapping to correct AD server when kerberos and netbios
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Enhancements and Addressed Issues

Ticket # Description (9.2.5.0443)

names differ for a single winbind instance.

802114 Juniper EX9253 and qfx5120-48y-8c, Type is "Unknown" and Version is
null in the Inventory.

802923 ClassCastException when creating/deleting trigger.

802942 Parsing issue with Mobile Iron Cloud integration.

803061 Multicast IPv6 addresses can now be excluded using the MAC address
Exclusion view. See MAC address exclusion in the 9.2 Administration
Guide for details. Note: After upgrade, toggle the option off and on in order
for the function to take effect.

804518 Local Radius leaves out Tunnel-Private-Group-ID and Filter-ID when
Quarantine enforcement is set to "bypass".

805866 Scheduled Shared Filter Reports result in error event.

806122 Roles not being assigned properly to Registered Hosts

806567 known_hosts file has duplicate host entries.

806616 RADIUS COA failing for a variety of devices when hosts are deleted.

807062 On upgrade, FortiNAC loses it eth0 IP Address.

807689 For endpoints managed in SSO integrations, FortiNAC no longer performs
L3 polls for Rogue hosts. They are not neccessary.

801948
803681

New deployed server will not start: java.sql.SQLException: Connections
could not be acquired from the underlying database.

809538 High Availability Database sync failure

810167
810180

Fixed fingerprints for iOS, FGT and FSW

811008 Netgear mib file has a feature to write a "hidden" field for Username and
Password which is not supported in 9.2.

807311 After FortiNAC services restart, MAB RADIUS session times out due to
FortiNAC being busy in SSH communication with the switch.

812169 Virtual Winbind service management queries periodically fail.

802908 RADIUS default server config not created on first startup.

805426 Fixed Null Pointer Exception in dynamic/dynamic-connection/host/{id} API
call.

790864 License upload does not verify MAC/UUID.

812589 Server doesn't start up / cannot log into FortiNAC UI.

811447 Upgrade failed due to: Operation CREATE USER failed for nac@localhost.
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Enhancements and Addressed Issues

Version 9.2.4

Ticket # Description (9.2.4.0438)

784618 RADIUS Failures after upgrading from 8.5 to 8.8 due to bad secret.

791327 FortiNAC is changing WAP Uplink ports Current VLAN to match the Default
VLAN.

797465 Nested group memberships not detected.

797778 AdminProfileManager has a null reference on Startup

799842 Endpoint Compliance - Policies: Takes 30 seconds to create policy,
exception occurs due to user clicking OK more than once

Version 9.2.3

Ticket # Description (9.2.3.0435)

769558 NullPointerException registering a rogue host from the Hosts View.

640841 SSH connection to some AlaxalA switches fail.

741373 Support for Mobile Iron V2 API

746585 Cisco Mac Move Notification Trap support.

750248 Unable to access the secondary server's Configuration Wizard in a High
Availability configuration.

752792 Device Profiling Rule registration not setting user/group membership.

753937 "Run NMAP" is now an option under Users & Hosts >Endpoint Fingerprints
in the UI.

754279 Host record marked "At Risk" due tothe generation of the "Persistent Agent
Not Communicating" alarm fail to be marked "Safe" after "Communication
Resumed" is generated.

754605 Added Tripp Lite DHCP fingerprints

758009 Added support to change VLANs via CLI on Allied Telesyn 8000S.

759018 Admin user with admin user profile permissions to Access, Add/Modify and
delete "Users" is unable to create a new regular user.

761276 User/Host Profile with Location does not use Portal defined in Portal
Configuration.

762071 Radius Auth/EAP Type columns empty in Network > Device > Ports >
Adapters table.
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Enhancements and Addressed Issues

Ticket # Description (9.2.3.0435)

762081 bsc-rename-ethers service fails on virtual machines.

762702 Improved FortiClient EMS polling.Previously, not all hosts were retrieved
upon a poll, causing some hosts not to register.

765477 FortiClient EMS test connect still fails after correcting a credential mistake.

765483 Fortinet EMS Version parsing is broken for EMS 7.0.

765899 EMS integration does not take into account theignoredAdapters.txt list.Can
cause Adapter/Host record generation with Fortinet virtual adapters.

766600 L3 polling support for Inhand IR915L Router

767209 Aerohive VLAN interfaces do not update on resynchronization after VLAN
ID or Profile ID change.

767942 Incorrect serial number used for CSF protocol used for SSO.

768329 Fail to determine port type for Cisco SG Switches with latest Cisco
firmware.

768673 OS name for OS X devices between DHCP and Fortiguard fingerprints do
not match.

768785 The GUI value "Registered Host" now displays as "Registered Host With
Owner".

768793 Race condition causing StaleStateException in FirewallSessionManager.

768822 FortiSwitch does not respond to Change of Auth (COA) packet due to
FortiNAC not sending the correct secret.

769851 Accounting Stop Message is discarded from Link Mode FortiSwitches when
using Local Radius.

770034 FGT 1800F labeled as 1500D

770192 Device Profiling rules stop processing as expected if HTTP method is used
and HTTP is timing out.

770208 Juniper switches fail to change VLAN on ports that are RADIUS enabled.

770548 Operating System custom attribute does not save in Device Profiling Rule.

770562 Device Profiler is performing all scans before checking for matches.

770695 Local RADIUS fails to find correct port on Extreme Summit X, preventing
proper VLAN assignment.

770730 Local RADIUS service goes down & does not restart when FortiNAC
processes are restarted.

770738 Ruckus API version detection not working for login API

770830 Device Rule Confirmation Failure event is not generated for some methods.
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Enhancements and Addressed Issues

Ticket # Description (9.2.3.0435)

770930 High L3 Polling frequency in environments with no SSOmanagement
configured.

771038 Port state actions without clear actions cannot be saved in the Event to
Alarm mapping.

771149 "Confirm Device Rule on Connect" does not work properly when "Confirm
Device Rule on Interval" is also enabled within the same Device Profiling
rule.

771157 MobileIron Cloud application poll can fail if licenseID is too long.

771422 RFC 3576 (CoA/RADIUS Disconnect) support for Extreme switches.

771506 Erroneous creation of redundant unique keys could overfill Group table key
limits.

771685 Apresia integration RADIUS 802.1x support incomplete.

771705 Change Inhand mib file to not use WRITE_HIDDEN in 9.1. and 9.2.

771743 FSSO tags not sent to FortiGate with multi-VDOM Fabric Connections.

771939 Automatically detect MAC format for RADIUS CoA requests for Juniper
switches.

772010 Wireless clients are not correctly processed on FortinetAPs when using
some multi-vdom configurations.

773053 RADIUS not mapping to correct AD server when Kerberos and NetBIOS
names differ.

773828 Not polling L2 information from PNetworks switches with latest firmware.

773841 Meraki Switch VLAN read/set fails when the ifIndex does not match the
dot1d index.

774202 Adjusted timestamp in syslog CEF message format.Previous formatting
prevented some systems from properly processing syslog from FortiNAC.

774724 Unable to filter Hosts and Adapters by status through API.

775973 Option to prevent auto-logging on users during authentication is absent
during L2 polling.

776123 Unable to add/modify groups starting with "!" (bang).

777124 A higher ranked policy more general than a lower ranked policy is still
honored if disabled.Lower ranked policy displays with a strike-through and
is ignored.

777126 Invalid MAC address doesn't skip non-matching OUI Method.

777400 Syncing "Role Based Access" group on the Control manager (NCM) may
delete sub-groups on the synchronized POD.

FortiNAC 9.2.6 Release Notes 17
Fortinet Inc.



Enhancements and Addressed Issues

Ticket # Description (9.2.3.0435)

777479 Control Manager (NCM) Dashboard tile is very slow to load.

777511 RADIUS support for HP 2910 and 2920 switches.

777778 Unable to switch VLANs on Juniper switch via 802.1x RADIUS in Proxy
mode.

778108 Windows domain check Device Profiling method fails if there is no domain
user logged on.

778112 Performance issue when performing group membership
lookups.Symptoms include usually high CPU utilization.

778157 L2 Polling issues with Cisco 9800WLC firmware 17.3.

778520 Added SQL query for GroupManager.getGroupsMembershipIDs() when
determining group membership in order to improve performance.

779873 FortiNAC processes taking unusually long to startup due to delays
resuming FirewallSessionMgr.

779901 Vulnerabilties in mysql versions less than 5.6.42.

780282 FortiNAC Events using old vendor name "Bradford Networks".

780626 Huawei Wireless controller imports nameless APs.

780790 CLI Failing to Alcatel Omni 6860-P48.

782374 L2 polling not parsing correctly for Motorola 7.X devices.

782740 Unable to read default and current vlans for Ruijie switches.

782744 Script install-winbind-virtual contains spaces around = assignments -
invalid

783227 Operating System updates from the UI fail when freeradius gpg key is not
present.

783544 Fortigate FG-200F improperly labeled as FG-201E.

783552 nac.service / ProcessManager not running at startup when no IP on box,
leads to processes down.

783621 Host import related Memory issues.

783944 Exception reading VLANs or SSIDs on Meru 4100 with firmware 5.1-93.

784601 Group membership lookup causing high CPU utilization.

784957 Not polling L2 information from Cisco ME-3400E-24TS-M router.

786401 Remote Scan -> Linux x86_64 -> 500 Error

786434 Allow changing CLI Passwords from Secondary and Application Servers.

786751 Added Distinguished Name (DN) field in Users View table.DN can now be
used as a filter.
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Enhancements and Addressed Issues

Ticket # Description (9.2.3.0435)

787562 Devices registered with incorrect icon type in MDM integration.

787563 NullPointerException (NPE) during L2 poll of Meraki.

787585 DHCP fingerprints are not matching DHCPmessage type.

788089 RADIUS service will not start after upgrade to 9.2 if winbind is not fully
configured.

788825 DHCP fingerprint additions, changes or improvements.

Added: "Camera","D-Link"; "Camera","TRENDnet"; "HVAC","Honeywell"

Updated: "Mobile","Samsung SmartWatch"; "Gaming","Nintendo";
"Network","Router/Netgear"; "Network","Router/D-Link";
"Network","Router/Trendnet"

Changed Device Type: "Network","Apple TV" -> "internet_tv","Apple TV";
"Network","Amazon Fire TV" -> "internet_tv","Amazon Fire TV";
"Network","Chromecast" -> "internet_tv","Chromecast";
"Network","DIRECTV" -> "internet_tv","DIRECTV"; "Network","DVR/TiVo" -
> "internet_tv","DVR/TiVo";
"Network","Roku Media Player" -> "internet_tv","Roku Media Player"

790403 ClassCastException in AirespaceSwitch during WAP read.

790747 FortiGate interface with VLANs does not show device connections to VLAN
sub interfaces for device detection traps.

0784737 0785526 Location and IPRange method match failure prevent matching lower rank
rules.

788729 RADIUS 802.1x proxy intermittently stops working.

791342 Manually Registered IP Phones get incorrect device type assigned.

758009 SSH access fails to Allied Tellesys AT8000S.

782433 Fix Integration for D-Link DGS-3130-30TS.

790854 Failure to properly read Cisco trunk ports results in undesired VLAN
switching.

791304 Selecting "Uncheck All"in an Admin Profile removes General permissions.

791401 By Day grouping is incorrect under Dashboard > Scans.

794362 System Update not reliably trusting fnac-updates.fortinet.net

791276 Clicking EULA Link When Logging In As New User Goes To Broken Link.

793920 Default Admin Profiles Have No Permissions

782760 Huawei S7706 switch does not correctly reflect the interface port number in
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Enhancements and Addressed Issues

Ticket # Description (9.2.3.0435)

Label column.

796105 Device Type incorrectly changing for registered devices.

Version 9.2.2

Ticket # Description (9.2.2.0421)

566257 Huawei wireless controller integration

609121 Support reading new SSID table format for Aruba IAP.

723743 Unable to change VLANs on Cisco 9500 switch with
TwentyFiveGigEthernet ports.

742523 LDAP server shows up as a rogue host icon in Topology/Inventory.

749846 Evaluation Time and High Availability tooltips are undefined in the License
Management view.

750597 Registered Topology devices appear as rogues in Endpoint Fingerprint
view.

750617 Add a column to Fortigate Sessions for Netflow/Sessions source.

753384 FortiNAC REST API: Added an optional boolean for "add-to-parents" that
determines if doing an add or replace.Previously, would remove existing
group membership unless both existing parent group and new parent group
IDs were specified.

753385 FortiNAC REST API:Add-members now able to add a group to another
group of same type (Host, User or Port) using Group ID.

753662 Telnet/SSH timeouts can now be configured per device from the CLI or from
the “Credentials” tab in the UI.

753923 Clicking Create Device Profiling Rule in FortiGate Sessions view only
displays FortiGate and Network Traffic as options in Methods tab.

754212 Security events not always resolving IP to MAC, resulting in inconsistent
security event generation.

754261 ForceSSO attribute not retained after upgrade to 9.2.

754619 Hosts CSV files with rule names could not be cleanly imported.

754700 NetFlow processing may sometimes attempt to remove already removed
records.

756299 Global option for changing the scope of target FortiGates not working.

756527 DPC revalidate doesnt resolve MAC-to-IP.
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Enhancements and Addressed Issues

Ticket # Description (9.2.2.0421)

757705 Legacy SSO requires tags to be configured even though they are not used.

757749 Added REST API support for Ruckus v6.0.Previously, wireless clients
connected to Ruckus were inaccurately showing offline in FortiNAC.

758282 DeviceManager NullPointerException

758514 Support for new REST API introduced in FortiGate version 7.0.3.

758535 Improved performance of CSV imports.Previously, import was very slow.

758976 Rebooting FortiNAC takes a long time due to FirewallSession table.

759181 Improved event storage management.Previously, databases had the
potential to grow unsually large, causing issues with upgrades and
database replication in High Availability environments.

759243 Fixed 'RadiusServer failed to intialize' message (typo and repeating
unnecessarily).

759245 DHCP fingerprints:Updated Wii and added definitions for LG internet TV
and PS5.

759280 Host details aren't updating as expected when there are multiple
fingerprints per source (such as a dual-boot system).

759709 Create Winbind instance - Returns error, throws NullPointerException

759768 RADIUS disconnect not sent for Juniper wired switches when using
RADIUS authentication.

760197 macOSMonterey hosts running the Dissolvable Agent are unable to obtain
configuration from server.

760394 Device Profiling is failing if FortiGuard method is used with higher rank.

760409 Cannot L2 poll Ruijie switches.

760424 Check for OS updates from the GUI is failing.

760596 API reporting wrong FortiNAC version in its system/local-properties/cluster
GET.

760616 VPN syslog messages not processed for FortiGates unless
VPNManagedNetworks attribute exists.

760861 FNAC-M synchronize issue - NullPointerException.

761362 ForwardingInterface debug:Enhanced API related output for FortiGate and
FortiSwitch integrations.

761623 Added option to find host by serial number in PA server if unable to find by
MAC address.Addresses issue where MicroSoft InTune sometimes returns
randomizedWiFi MAC Address (which are ignored by FortiNAC).

762240 Duplicate Groups in FortiNAC causing SSO Tags to not be sent.
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Enhancements and Addressed Issues

Ticket # Description (9.2.2.0421)

762421 Proxy RADIUS to Cisco switch fails due to port lookup failure.

762438 EMS server integration failing to correctly report compliance.

762456 FortiNAC attempts to Deauth hosts that are not managed by FortiNAC from
Aruba Controller SSID.

762743 Accounting Stop Message Discarded from Link Mode FortiSwitches.This
prevents hosts from being marked "offline" as expected.

762963 FortiNAC-Manager Guided install doesnt change root/admin CLI
passwords.

764011 Control Manager (NCM) Server List sometimes takes a long time to load.

764415 Unable to resume control to Primary Server via Administration UI in High
Availability configuration."Resume Control" button generates an error.

764518 Device Profiler WinRMMethod -> Credentials are required to be in
userPrincipalName format but shouldn't be.

764818 Large network address scopes assigned for VPNmanaged addresses can
create memory and CPU utilization problems.

765187 Routes no longer present after upgrade to 9.2.1 due to hsAddRoutes not
working properly.

765227 Roles on Manager (NCM) cannot be changed.

765252 Exception in CheckMacRunnable after initializing database.

765411 Not able to change VLAN's on Cisco Meraki MS250-48FP.

765562 Resynchronization of SSO sessions does not re-add any missing SSO
sessions.

766132 RADIUS service is incorrectly enabled by default on new/unlicensed OVA
installs and Manager (NCM).

766179 FortiNAC sends wrong keyword for SSO Dyanmic Address API.

766595 NoSuchProviderException in Radius Certificate initialization logic.

766858 Administration UI not accessible after ResetToFactoryDefaults.

768711 Cannot import host record CSV due to serialization error.

764017 New DHCP fingerprint definitions forFortiFone and FortiCamera (Operating
System).
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Enhancements and Addressed Issues

Version 9.2.1

Ticket # Description (9.2.1.0415)

666285 FGT interface with VLANs does not show device connections to VLAN sub
interfaces

684953 Changed remaining "Topology" labels in UI to "Network inventory"

736125 Netflow protocol support for device profiling.For details see Netflow Support
in the 9.2 Administration Guide

740229 Control Manager (NCM): Renaming scans and syncing creates duplicate
scans

741639 Parsing issue in reading Vlans and L3 data of DellSwitchOS10 models

741929 Control Manager (NCM) is throwing an IOException for Too many open files

742889 Virtualized Devices UI/Tab should not show the internal dmgmt-vdom

744100 Unable to pull mac address information from Ruckus running V 5.2.Ruckus
requires REST queries to contain a serviceTicket

744313 SNMP errors for Mist APs in Event Logs

746629 Support for Aruba switch mac notification traps

746729 Support for MobileIron cloud solution

746986 Separate app servers unable to update OS when using fnac-
updates.fortinet.net

747276 Mist APs created with incorrectly formatted MAC address, L2 polling
doesn't work

747324 When using port security on this switch, FortiNAC can no longer see any
MAC addresses connected and is unable to read anything

747378 Unable to register multiple hosts as a device from host view

747920 When runnning Device Discovery using SNMPv1/v2c Security Strings, v2c
is now used by default.If v2c fails, v1 is used

747935 Local RADIUS - "Authentication Failure" event/alarm is triggered after
successful authentication

748041 Default Portal Self-signed cert is owned by root, should be nac. Causes
deployment of new self-signed certs to fail

748984 When a fingerprint is updated with new data, only the "Last Heard" time will
now be updated.The "Creation" time will remain the original value

749565 FortiGate Version parsed incorrectly for security fabric dynamic address
integration.Any FortiGate with firmware greater than 7.0 but less than 7.0.2
will incorrectly appear as if it supports the new dynamic address
functionality
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Enhancements and Addressed Issues

Ticket # Description (9.2.1.0415)

749837 Potential ClassCastException syncing objects between Control Manager
(NCM) and pods

749885 Null Pointer Exception when creating FortiGate model if API access fails

750264 Network Inventory incorrect after moving FortiGate with managed AP's to
another container

750287 Rebooting Ruckus SZ Controller causes SSID configurations to return to
use Inherited

750513 SSO information is not sent in 3rd party SSO integrations

751092 Endpoint Fingerprints > Set Source Rank > Modify without changes throws
an error

751158 Rename existing RADIUS attribute group throws sql exception, can no
longer retrieve all groups

751181 FortiNAC fails to login to CLI of Cisco SG/SF switches with the word "All" in
the banner

751194 When adding a new Security Fabric Service Connector did not default to
port 8013 when it should

751204 DPC Rule creation from fingerprints lack details

751408 Local RADIUS should use VDOM for radius mode when SSID context
exists but is set to inherit config from device

751472 RADIUS service will not start after upgrade to 9.2 if winbind is not
configured

751753 Ports view blank for some FortiSwitches in Link mode.

751780 Error dialog is displayed when registering an adapter as a device in
Topology

751800 User host Profiles > add new User/Host profile > "Who/What by
Radius Request Attribute" is not being synced with Control Manager
(NCM)

751853 Database is not fully initialized on unlicensed start-ups

752512 Unable to Assign VLANs on Ruckus Using Local RADIUS

752785 Control Manager (NCM) Synchronization can produce Null Pointer
Exceptions in the logs

752788 Alarm view fails to load due to Null Pointer Exception

752838 Profiled Devices edit Rule Settings unable to be disabled

752951 SNMP occasionally parsing MAC addresses incorrectly

753414 Roaming Guest configuration left off of Aruba model configuration
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Ticket # Description (9.2.1.0415)

753566 Dropdowns in the VDOMConfiguration view are bounded by the body of
the dialog

753597 Hosts connected to Nokia switch (ISAM FX-4 7360) incorrectly show offline

753908 Unable to import/export Device Profiling rules via UI or REST interface

754256 Null Pointer Exception in DeviceInterface when initializing SSO for
FortiGate and in BridgeManager when processing traps.

755323 Assigning VLAN ID to Dead End Vlan fails with UI error "Invalid ID - Dead
VLAN"

756126 Unnecessary FortiGate related log messages printing by default.Moved
these messages to debug level logging

756133 500 error in Policy Details appear when matching a policy using RADIUS
Attribute Filters in User/Host Profile

741938
753267

Policy Details in GUI shows wrong results.

Version 9.2.0

Ticket # Description (9.2.0.0409)

518423 802.1x support for Aerohive SR2208P

522462 Trigger "System Created Uplink" Events for Learned and User created Uplinks

543215 Make change in mib to not use Native Vlan on Juniper EX switches

594554 VLAN Switch Success Event and Alarm to contain the "from" and "to" VLAN information

600122 Add a configurable delay after receiving a warm start/cold start trap before FortiNAC engages
with a switch

601831 Added support for Swagger Editor (used by FortiOS)

611613 Topology > Set Model Configuration option does not apply selected "Send Groups to the
Firewall" and "Selected Groups" options for the FortiGate Virtual Device Model Configuration.

640641 The dashboard is not showing any Mac agents. The total agents reflect the correct number but
the mac column is zero.

650216 Unable to set firewall tags for PaloAlto model

650626 FortiNAC System Date Format changed to YYYYMMDD_HHMMSS.

659675 Provide Location (switch/AP and port), IP address, and "Connected Container" information into
the "Rogue Connected" and "Device Created" events.
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Ticket # Description (9.2.0.0409)

663957 Alcatel 6560 not switching VLANs

665011 Added support to configure multiple Local RADIUS Servers

666660 If a shared filter has an ! in it, a delete or edit silently fails

671704 FortiGate VPN Host is incorrectly registered as a device with no "Registered To" information and
with "NAC-Default" Role

671997 Juniper Flex-CLI not working due to configure mode prompt

672391 Generate MAC Spoofing events when spoofing and spoofed machines are on the same switch.
For configuration instructions, refer to the Administration Guide.

675847 VPNModel Configuration screen authentication method now displays LDAP checked by default.

676232 Host with a disabled logged on user is not moved to dead end.

677981 Improved multiple VDOM support for FortiGate VPN integrations. Previously, FortiNAC was
unable to determine correct tags to apply to sessions

682525 Unable to register MS Intune endpoints that only have an ethernet adapter

684657 Improved the communication method between Control Manager (NCM) and pods by using REST
API and certificate client authentication over HTTP Requirements: - Manager must be installed
with License key containing certificates (not required for pods). For more information see related
KB article FD52784 - Firewalls allow TCP port 8443 between Manager and pods If the above
requirements are not met, the Manager will use original communication methods

685763 Changed Proxy Radius logic for VDOM lookup to use VDOM from attribute Fortinet-Vdom-Name
if present in auth request

688265 Account Requests > Approve Request doesn't close the overlay on success

689104 Send separate Emails for guest registration details and password

691837 Add GUI functionality to enable or disable masquerading e-mail as other addresses

691918 Improved Local RADIUS/winbind service operation visibility and debugging in GUI

692461 Modifying group members not shown in admin auditing logs

692995 Improved Dashboard view

693625 Groups service does not check for usage across different configurations

696239 Port Channel Support for HP Switches

696640 Access to gui is randomly lost

697296 Add vendorCodes directory to System Backup

698090 Fortigate L3 polls do not support reading IPv6 arp data

698728 Telnet/SSH to a FortiGate fail when post-login-banner is enabled

699606 A warning message now appears when attempting to install a legacy (NetworkSentry) license
key using the UI
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Enhancements and Addressed Issues

Ticket # Description (9.2.0.0409)

700276 Add Contact Status Polling for Link Mode FortiSwitches.

700580 Fortigate L3 Poller throws exceptions for static arp entries

700580 When polling the Fortigate, if there are multiple ARP entries for the same MAC address, the
newest entry may not be used.

700610 Kiosk Page is Not Loading

701378 All API requests to a FortiGate fail when the post-login-banner is enabled

701764 Portal - Self Reg Pending view not visible when instructions are set to be inline

702259 Hostname information collected from FortiGate firewall sessions is no longer used for updating
rogue host records.The information was sometimes inaccurate

702941 Query OUI,FortiGuard and NMAP for every new rogue

705017 Settings > System Communication >Incorrect help text for Message Templates

705845 Searching groups by name in Roles and Network Device Roles views doesnt work

707166 When doing a quick search from Host View, if a host has multiple adapters that all match the
search query, each Dynamic Client is displayed independently

707284 VLAN ID and VLAN Name drop-down menu contents are now sorted in the Model Configuration
View

708635 WinRM/WMI PowerShell Command Restriction by McAfee EDR - EncodedCommand

708649 Added Local RADIUS Server support for EAP-FAST. For details, see Administration Guide

708651 Added support to authenticate Cisco Access Points using EAP-FAST and dynamically provision
network access.

708652 New Device Profiling Method: ability to check certificate field to classify hosts & devices

709269 FortiGuard Device Profiling method is not available on the Control Manager (NCM)

709278 Secondary Server in High Availability responds to RADIUS after Primary Server resumes control

709293 Added support to display FortiAnalyzer connection state

709294 When using macOS browser to add FortiAnalyzer as a log receiver in the Administration UI: -
Default port is now set to 514 - Ability to populate the Security string has been removed as it is no
longer used

709318 SSH Known host keys can now be removed on-demand from the Credentials tab or automatically
whenever a device is removed

709447 The text on the social login buttons sometimes spills over edge

709464 Appliance installation is now done through the Administration UI as opposed to a seperate
Configuration Wizard

709559 Mist AP L2 Polling failure

709561 Passive Agent Policy group pull down does not show any AD groups if one of the AD servers is
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Ticket # Description (9.2.0.0409)

not reachable

709661 Automated identification of potential L3 sources post device discovery

709861 Added support for new API introduced in FortiGate/FOS version 7.x

709965 Server List panel in Control Manager Dashboard takes several minutes to build

710408 Implement new FortiGate v7 FSSO REST API

710576 Additional data needed for FortiNAC CTAP reports

710646 Device Profiler Windows Profile method not working in HTTPSmode due to Command Line Too
Long error.

710971 Update MacAddressTable command to get RADIUS working for Huawei switch

711025 Removing an MDM service connector while there is poll in progress does not remove it

711377 Support for tunneling REST API requests over CSF

711510 PortLinkType not updated after resync interfaces

711696 Failure to switch VLANs on Cisco SG200-50 switches

712375 User/host profile does not match policy if Adapter information is used

712591 Misleading password configuration pop-up box in High Availability configuration

712658 Network Inventory takes a long time to load

712678 Clicking on a user count in the user summary panel on the dash board does not create a Filter
when it opens Host View.

712695 Administration UI authentication fails when using a "+" sign in the password

712887 Fixed issue that might cause Device Profiler custom rules to not match correctly

712889 Only primary interface is imported to FortiNAC when host has multiple adapters

712980 Fail to display interfaces on certain Extreme switch models due to unexpected port format

713181 Added an import button to enable uploading hosts from an external file into the datatable.

713259 Meraki Ports/Interface creation issue when the Group Policy name is assigned to Production
Logical Networks

713505 Nokia switch port names do not contain switch name.

713591 NEC QX Switches are discovered as generic SNMP devices.

713629 System/Settings/System Communication/Email Settings -> Test Email settings works but
SendEmail tool doesnt

713870 Failing to read arp cache on H3C

713962 Added L3 support for Versa router

714399 Exception during modeling leads to Cisco in locked state
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Ticket # Description (9.2.0.0409)

714641 Device Identity view has been replaced with Endpoint Fingerprints view. Located under Users &
Hosts > Endpoint Fingerprints. See new features.

714692 Removed iOS and Android from the "Add Device Profiling Rule" view.

714694 New Fingerprint database to accommodate multiple fingerprint sources. Data is displayed via the
new Endpoint Fingerprints view.

714702 Not reading L3 from all VDOMs on a FortiGate.

714764 New install>Need a way to upload a license key from the client file system

714768 Fixed mapping for Alcatel-Lucent Enterprise OS6860E-P24

714808 Ruckus L2 poll does not work with version 6

714947 FOS group dynamic firewall address (FSSO) integration

714954 Adding Virtual and Virtual Guest options to adapter Media Types

715251 When RadiusManager debug is enabled and an unknown RADIUS attribute is received,
NullPointerException is printed and FortiNAC stops processing the request

715302 Added the "screen" command to the repository and image

715316 FSSO Race condition leaves some hosts with incorrect logon status

715418 Fix debug in TrapHander to not mislead on linkup vs linkdown traps

715678 Introduce USG SKUs to restrict contact FortiGuard server, FDN Server and FortiNAC software
download server in US only

716371 IllegalArgumentException thrown in PersistentAgent#isLinkLocal when called with an IPv6
address

716411 FSSO tags are not sent when host role changes.

716599 FortiNAC drops RADIUS packets at times of peak usage

716603 Fix scripts to make them POSIX compliant

716897 System>Settings>Trap Mib Files throws exception and does not function

717912 Group Membership performance is too slow to handle load from policy engine

718168 Add a convenience method to modify a local users password

718402 SvgIconInterface isnt being loaded properly during build

718783 FortiGate VPN failed to register for syslog and failed to login correct user if connection was lost
without notification.

718802 Unable to collect host/user information from 6.4.3 EMS server.

718831 InTune group add causes database issues

719360 Unable to run install.bin if have legacy license key without High Availability

FortiNAC 9.2.6 Release Notes 29
Fortinet Inc.



Enhancements and Addressed Issues

Ticket # Description (9.2.0.0409)

719780 Catch All rule name inDevice Profiler is no longer modifiable

720071 9.1 Online Help Generates 404 Error

720129 Upgrade to 9.x fails with "Unsupported group policy type java.util.ArrayList"

720204 Updated FortiNAC log schema for FortiAnalyzer

720360 Added FirmwareVersion attribute on the Aerohive SR22XX/Unifi switch models for 802.1x
RADIUS CoA functionality

720439 RadiusManager property included in "radiusManager.properties" file

720467 FortiClient EMS integration should support the mac_list property in the API

720471 Added cyber-blue MAC address 00:1A:7D:DA:71:15 to IgnoredAdapters.txt (Custom Ignored
Adapters List)

721204 Added Mac Notification support for Dlink Switches

721566 Custom Scans Registry-Keys view produces an error

722811 In MDM integrations, fingerprints are now created with the hostName, OS or entity values for the
host instead of updating the host record directly.These are viewable in the new Endpoint
Fingerprint view

723107 Add Fingerprint from Persistent Agent data.These are viewable in the new Endpoint Fingerprint
view

723563 Event Alarm Mapping not adding %host% or %event% information to Email Action

723851 DHCP Fingerprint for Mac OSX Bug Sur missing

724173 Fix CoA on Fortigates with FortiLink switch, where secret is defined on the switch

724363 Duplicate online hosts with same mac address are displayed under Adapters in Topology view.

724383 FNAC sometimes failed to poll some clients connected to FGT/FSW FOS7.0.

724769 Edit Role -> Groups -> Groups arent filtered

725009 Imported LDAP group does not map to Administators

725360 Fix potential ClassCastException in MibObject

725604 Host is auto approved by FortiNAC even when an approver is configured in Standard User Login
Portal.

725629 Unable to properly manage Aruba 9012WLC due to incorrect mapping

725746 Communication issues between Control Manager (NCM) and POD causing Endpoint
Compliance failures

725751 "Sync initiated" event added.Generated when a synchronization of servers by Control Manager
has been triggered.Provides server IP, the user who triggered the sync and status

725757 Scheduler Modify dialog, Next Scheduled Time validator doesnt accept new time format

725972 Remove unnecessary startup RelationInterface message from output.master
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Ticket # Description (9.2.0.0409)

725981 LEAP support has been removed from the Local RADIUS Server configuration

726024 GA Renumber failed due to attempting to create + push existing tag

726099 FSSO processing performance enhancements

726329 Appliance installation is now done in the Administration UI.There is no longer a separate UI

726329 Basic Network config wizard page control alignment is off, no need for multiple columns.

726410 When a FortiLink Switch is renamed, the device and port model names in FortiNAC are not
updated.

726458 DPC rule does not revalidate upon connect for RADIUS clients ("Confirm Device Rule on
Connect")

726678 Added custom Network Devices Admin Profile permission set to view/hide the device model
Credentials tab

726694 A Fingerprint is now created when FortiNAC updates a host record after reading the FortiGate
Firewall Session table.

727066 Error dialog when setting device mapping to Generic SNMP using set device mapping option.

727336 When collecting ARP information from ArubaOSWLC, the user table that contains the correct
ARP entries is not being queried

727710 On upgrade from 8.8 to 9.1 or higher, the error
"com.mysql.jdbc.exceptions.jdbc4.MySQLSyntaxErrorException: Unknown table
'bsc.DatabaseAuditView'" may appear in the logs

727831 Fingerprint attributes are not returned via REST get requests

728160 MySQL Exception Incorrect integer value: 'GuestSelfRegistration' for column
'sendPasswordSeparately' in output.master

728406 Proxy RADIUS packet debug - attempts to convert non-human readable octet string attrs, clutters
output

728409 Hosts and Adapters views only show 999 Entries.The REST API is returning just the count of
records in the current page

728677 Local RADIUS Server fails to disconnect clients from Ruckus Virtual SmartZone (SZ) controller
due to missing RADIUS attributes

728719 Add Device Profile Rule > Vendor OUI > Clicking Vendor OUI link results in HTTP 500 Error

728862 Enhanced DeviceImport CLI tool including SNMPv3 support. For details on all options, type
"DeviceImport" in the CLI

729007 NullPointerException during V3 device creation via API when no v1 community strings provided

729421 Enhanced device type classifications based upon OUI

729585 Cisco ASA VPN clients not moved to the unrestricted group due to multiple values returned when
reading object-group
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Ticket # Description (9.2.0.0409)

729599 Obtrusive error popup thrown upon navigation to Topology view

730236 Failure to read SSID on Ubiquiti causes all SSID models to be removed

730601 Changing Endpoint Complaince scan causes agents to be rescanned even when monitors were
not changed

730789 When wired clients are authenticated by the Local RADIUS Server, the default VLAN is returned.
Network Access Policy look-up is skipped

730823 Multiple calls to edit a User Host Profile via the API results in failure after the first attempt

730857 No error message when DHCP scopes fail to import from file

730892 VPN solution L2 polling process excessively long

730908 Errors with secrets with special characters like %

730990 UI rendering for Authentication Policies/Configs tied to wrong permissions

731215 Added support to read L3 tables on Dell OS10 switches with VRFs configured

731580 Exception is displayed in server log during initialization

731597 Exception is logged when no devices present

731633 SQL Exception is thrown during FortiNAC server startup

732229 Missing event and alarm definitions for ADMIN_PROFILE_MODIFICATION

732265 Aruba Controller model configuration view is not showing supported RADIUS controls

732340 dumpports does not show port IP address (requestString)

732580 Added "sar" output in grab-log-snapshot

732614 Clicking Read VLANs on Model Configuration view fails due to not-a-function error

732965 Local RADIUS Server functionality not working properly upon failover or recovery in High
Availability configuration

733232 Unable to save private filters

733903 Setting Host Expiration field to "Never" resulted in inaccurate expiration dates (example
12/31/1969)

733969 Unable to poll Airwatch MDM hosts. Although MDM poll appears to complete, new registered
hosts are not created

734792 API communication issues with FortiGate

734895 Unable to parse L2 table on Dell OS10 Switches

735444 All RuggedCom switch models are shown as RSG2300 in the model configuration views

735553 CLI and Vlan switching not functioning for Allied and Rugged devices

735791 Secondary servers do not retain contract entitlements
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Ticket # Description (9.2.0.0409)

736110 Excessive exceptions for DatabaseObjectAlreadyExistsException seen in logs

736125 Added Netflow protocol support for Device Profiling

736465 MAC address label is hidden if the IP address field is disabled in the Game Register portal
configuration

736501 Cisco ASA VPN users are not always unrestricted after connecting

736553 Log format has changed to include the thread ID and to remove redundant timestamp in
heartbeat messages

736796 Added L3 Device Identification UI.

737244 Add REST API call to confirm device profiling rule in DeviceIdentityService

737732 FortiGate FSSO functionality is now configurable using address scopes and address groups for
more flexible configuration

737740 Added PolicyHelper debug control / visibility to RADIUS log UI for improved troubleshooting

737779 Added ability to configure CLI Passwords using the Administration UI

738093 ISO build missing bc package

738096 Add checkboxes to support proactive nmap and Fortiguard method profiling

738257 Improved user look-up method to handle the different userID formats when matching Network
Access Policies based on user record criteria. Previously, this was seen to cause delays in
responding to RADIUS Accepts in some environments

738375 RADIUS processing performance issues when RadiusManager debug is enabled

738388 Debug was added to indicate when System > Settings > Updates > System protocol is set to
SFTP.This protocol has been deprecated

738721 Device Identity view has been removed

738805 Unable to set SSH port on Device Credentials page in version 9.1.2

739112 Improved default level log output to include more informative messages

739131 Need to replace mysql-connector

739465 Removed Local RADIUS requirement that request must contain Service-Type=10(Call-check)

739674 Local RADIUS MAB & CHAP fixes

740034 Exception in RadiusManager with logging enabled

740723 Devices with VDOMs that specify local radius server/secret and use the mgmt IP - on restart the
nas DB tbl entry is removed

740749 Local RADIUS can only handle secrets of 60 characters or less

741811 Update of Adapter IPs causes empty replaces of DYNAMIC table

741864 Switching port vlans fails for Rugged devices
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Ticket # Description (9.2.0.0409)

741929 Control Manager (NCM) is throwing an IOException for Too many open files

741952 No response in UI when adding new network devices

741954 Add ability to read ethernet adapter for Google GSuite devices

741994 SSIDs added to groups with wrong type when added via SSID -> Group Membership preventing
policy engine match on the group

742260 NullPointerException in DeviceServer.getVoiceVlans()

742261 NullPointerException in ProbeTelnet.getProbeObjectsByInetAddress()

742347 IndexOutOfBoundsException in BridgeManager.VlanVerifyVector.put()

742861 More granular OS information collected from agents.Displayed in Agent Fingerprints

743381 Missing description for Radius in System/settings/Authentication/Radius

743535 License for jersey packages is listed incorrectly as EPLv2/GPLv2 in Help > Legal view

743543 Caching of dot1qIDtoVIDMappings not working on Juniper switches

744025 Location based Device profiling rule does not work consistently

744100 Unable to pull mac address information from Ruckus running V 5.2.Ruckus requires REST
queries to contain a serviceTicket

744371 Fixes potential performance issue in table views.

745083 Control Manager (NCM) Sync fails with ArrayIndexOutOfBoundsException

745133 SSH is intermittently failing to some Cisco devices

709030
710957

Improved the speed of Device Discovery

716411
715316

FortiGate VPN hosts marked At Risk do not trigger a network change.FSSO device
synchronization doesn't work properly with VDOMs.

717912
715316

Group Membership performance is too slow to handle load from policy engine

733892
733914

LicenseTool APPLIANCE shows EFFECTIVE count/level/certs if both are requested

733903 Setting Host Expiration field to "Never" resulted in inaccurate expiration dates (example
12/31/1969)

735520
729033
731645
731193
728989

Agent 5.3.0 package included

739380 AirWatch does not retrieve all MAC addresses for enrolled devices
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Ticket # Description (9.2.0.0409)

745058

742929 The number of Operating System and Anti-Virus program options in the Scan Configuration have
been reduced. Only those currently supported or commonly in use are now listed. Systems
initially installed with 9.2.0 will have this change applied by default. Upgrades will have this
functionality enabled upon the first auto-definition sync.
For a list of available Operating Systems and Anti-Virus programs, see KB article FD53449.
https://kb.fortinet.com/kb/microsites/search.do?cmd=displayKC&docType=kc&externalId=FD53
449
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Known Issues Version 9.2.6

Known Issues Version 9.2.6

Ticket # Description (9.2.6.0451)

856217 Hosts discovered by MDM are getting incorrectly marked as having a
Persistent Agent.

809769 HTML is not supported when using "Guest Account Details" message type
template.

874037 GUI > Users & Hosts > Host View > Quick Search - Unable to locate host by
hyphen or no delimiter.

882265 FortiNAC is not sending the correct serial number field to FAZ.

780312 FortiNAC does not integrate with Azure Active Directory due to SAML
connection requirements.

878836 Intune MDM Integration 'Invalid Audience' when using an App registration in
the Azure Government cloud.

878836 Intune MDM Integration 'Invalid Audience' when using an App registration in
the Azure Government cloud.

866378 Custom Login using a Guest Self Registration account fails with error
Registered Client Not Found.

875720 REST API v2 query for Scan Results returns no results.

869097 Prioritize the IP -> MAC value provided by RadiusServer for managed
wireless clients.

867183 Unable to perform seamless failover of Aruba Controller with FortiNAC.

754346 Default filter used when selecting Port Changes for a specific device port
does not work.

874812 Private VLAN switching is not working > Cisco switches.

878059 Using Location that specifies a device will not work if that device is a
FortiLinked FortiSwitch

877942 Performance issues related to Firewall Session table growing to large.

834094 834089 845493
845505

When a sync is performed on the Network Control Manager, if an IO error
occurs, global device profiling rules, global port groups and port group
membership may be removed from the managed pod due to returning an
empty list.

811404 807309 Admin UI showing error "You do not have permission to access this page".
Workaround: Restart tomcat-admin service.

686910 714219 Control Manager (NCM) communication issues when the NAC systems are
connected through the WAN. For details see related KB article
https://community.fortinet.com/t5/FortiNAC/Technical-Note-NCM-
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Ticket # Description (9.2.6.0451)

communication-issues-with-systems-across-WAN/ta-p/192434.

849497 The FreeRADIUS service is restarted whenever a new network device is
modeled even if local RADIUS is not enabled.

849140 In a High Availability environment, the Network Control Manager's API
query to a managed pod's Secondary Server will return the serial number of
the server in control. If the server in control is the primary, the query to the
secondary will fail.

845930 When a managed pod is removed from the Network Control Manager, not
all references to the previously managed pod are removed from the
database. The result is a “Sync failed to replace xyz” error message when a
sync is attempted.

845412 When a sync is performed on the Network Control Manager, modified group
names are not synchronized to the managed pod.

845003 Unable to register hosts to usernames in format of an email address. An
“Error – Failed to Save Host – null” message appears.

845000 Unable to add a new LDAP or local user account when the username is in
the format of an email address. A “Failed to modify User” message appears.

842370 Radius will ignore incoming requests from a device if the Model
Configuration or VDOM configuration does not specify a secret and local
radius mode (and for a VDOM, additionally a Source IP address).

842280 Guest Self-Registration, when configured to e-mail users their credentials,
now requires 2 separate e-mails (1 containing username and another
containing password).

842122 An incorrect license utilization percentage is displayed in the Network
Control Manager Dashboard license widget.

841907 The Network Control Manager can experience lengthy response times
when querying hosts from the managed pods.

841825 Guest Self-Registration fails if using SMS.

840796 InTune records without unique serial numbers can cause issues with
FortiNAC's device lookups.Records are currently looked up via serial
number first and MAC address second. Lookup order should be reversed.

838525 Configuring Remote Backup results in a "HTTP Status 500 – Internal
Server" error.

836606 When polling GSuite, if communication times out part way through, the poll
is still reported as successful even though not all records were obtained.

836435 Unable to read VLANs on Huawei 6508WLC.

836146 radius.log file can grow too large if debug is left enabled.

836137 Existing results disappear on RADIUS -> Winbind view if the results are
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Ticket # Description (9.2.6.0451)

sorted by Joined column.

835782 Applying a license key in the Configuration Wizard can result in a "HTTP
Status 500 – Unable to compile class for JSP" error message.

835405 Admin UI is inaccessible after running the Configuration Wizard during a
new deployment. Logs indicate the keystore is unrecognized.

835149 When an endpoint is registered as a device in Host AND
Inventory/Topology, it is not possible to edit the host role. The option is
available, but changes do not apply.

835143 When querying Microsoft Intunes network details, FortiNAC does not
validate whether the response is successful. As a result, additional queries
fail until the token is refreshed.

834461 All required radius CoA attributes are not sent to Ruckus controllers in a
disconnect request.

833735 Host icons in the Inventory view are not updated until a Layer 2 poll occurs.

833327 Routes specifying an interface are no longer present after reboot or restart
of processes.

833305 Guest account password is unmasked when printing badge even though
admin user does not have password viewing permissions.

832313 Device integration does not handle CLI connections to infrastructure
configured with keyboard-interactive password challenge.

830932 Entitlement Polling Success event is not listed as an option for triggering or
clearing an Alarm Mapping.

830581 IP Phones will not match policy if host group membership is configured as a
User/Host Profile requirement despite the phone being a member of the
host group.

829702 FortiGate wireless clients cannot connect after a FortiNAC software
upgrade if the FortiGate device model's RADIUS secret is not
populated.This is true even though the VDOM radius secret is populated.

829019 Manager's (NCM) Resume Control button on the Dashboard in a High
Availability environment does not restore control to the primary Manager.

828128 Unable to add Allowed Domains containing underscore symbols.

827870 When a FortiGate device model's IP address is changed in the Inventory
view, add/delete/move syslog messages from the new IP address is
discarded until FortiNAC services are restarted.

827283 Roaming Guest Logical Network missing from FortiGate Model
Configuration.

826913 Creating a Network Device Role using Direct Configurations reverts to
Logical Networks.
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Ticket # Description (9.2.6.0451)

824088 Unable to update existing Registered Host records using Legacy View >
Hosts > Import.

820160 Roles view is not available with a Base License.

818504 Linux Persistent Agent fails to install using the .deb package.

817040 FortiNACManager fails to connect to pods configured for L2 High
Availabilty with a virtual IP.Manager is querying eth0 IP instead of Virtual IP.

814183 Unable to view all Certificate Details in the Certificate Management view.

813652 Security Alarms are not generating from Security Events.

811783 Links in the Persistent Agent Summary panel produce redundant results.

810574 Unable to scan message when using Dissolvable agent if scan
configuration label contains non US-ASCII characters.

808088 Alarms stop generating notifications.Affects environments with notifications
configured for high frequency alarms.

800255 Device Profiling IP Range Method does not include .255 when using
wildcards.

793634 MDM Server Last Polled and Last Successful Poll information removed in
9.x.

792968 Legacy View for Users & Hosts > Hosts does not display items in tables.
Workaround: Enter “*” (asterisk) in search field.

791751 Host Import - importing same file twice results in "null" error and exception
in logs.

791442 Able to delete a Portal Configuration which is in use by a Portal Policy.
Removal is done without warning the user.

783304 DHCP responds with unexpected addresses in the DHCP-Server-Identifier
attribute.This causes release/renew to fail.Affects appliances configured for
seperate isolation networks (Registration, Remediation, DeadEnd, etc).

776077 Local Radius to Winbind connection cannot be secured at this time.

774048 L2 HA + VIP Pairing Process Failing.Configuration completes but leaves
both appliances in a "processes down" state.Workaround: Reboot
appliances.

770091 Port changes/VLAN assignments made using Local RADIUS are not being
logged as port changes.

767548 Register Game system with Host Inventory success page is not working.

766850 Landing page defined by an Admin profile is not honored. User with that
Admin Profile is presented with the FortiNAC Dashboard instead.
Workaround: Manually browse to intended landing page.
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Ticket # Description (9.2.6.0451)

765172 Configuration Wizard does not check whether user input subnet masks are
valid.

762704 After clicking the 'restart services' button when applying SSL certificates to
the Admin UI Certificate Target, the prompt does not clear and there is no
confirmation dialogue (even though it was successful). Clicking the 'restart
services' button again generates an error.

761745 Mist AP - Port Connection State NOTWAP Uplink.

760926 Removal/Addition of LDAPmodel can cause user attribute synchronization
issues. For details and workaround see KB article
https://community.fortinet.com/t5/FortiNAC/Technical-Tip-Removal-
Addition-of-LDAP-model-can-cause-user/ta-p/209296.

754346 Selecting Port Changes under the Ports tab of a specific device in Network
> Inventory does not display expected results. For details and workaround,
see KB article https://community.fortinet.com/t5/FortiNAC/Technical-Tip-
Default-filter-for-Port-Changes-does-not-populate/ta-p/209297.

752538 When in the Users & Hosts > Applications view, selecting an application
and clicking the Show Hosts option displays a page that does not provide
accurately filtered results. Workaround: Navigate Users & Hosts > Hosts
and create a custom filter to list hosts associated to an application.

710583 L2 Polling Mist APs can result in more API requests than Mist allows per
hour.

708936 FortiNAC will logoff SSO for sessions that remain connected to a managed
FortiGate IPSec VPN tunnel after 12 hours.

708720 Policy evaluation may not be triggered after a host status update in
Microsoft InTune. This can prevent the host from being moved to the proper
network. For details and workaround see related KB article
https://community.fortinet.com/t5/FortiNAC/Technical-Tip-Policy-
evaluation-not-triggered-after-Microsoft/ta-p/203843.

699106 After a reboot, FortiNACmay change the Native VLAN on a wired switch
port following a layer 2 poll. This may cause issues for ip phones should
they connect to a port where the native/default VLAN isn't the correct VLAN.

695435 FortiEDR is currently not supported.If required, contact sales or open a
support ticket to submit a New Feature Request (NFR).

694407 Linux hosts running CrowdStrike Falcon sensor 6.11 and later are not being
detected by the agent. This causes hosts running CrowdStrike Falcon to
incorrectly fail scans. For details and workaround, see related KB article
https://community.fortinet.com/t5/FortiNAC/Troubleshooting-Tip-Linux-
hosts-running-CrowdStrike-Falcon/ta-p/202694.

682438 Page Unresponsive' error when exporting hosts.For details and
workaround see related KB article
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https://community.fortinet.com/t5/FortiNAC/Technical-Note-Page-
Unresponsive-error-when-exporting-hosts/ta-p/193878.

674438 Processes Scan Type option is not available when creating custom scans
for macOS systems.

641036 Multi-factor authentication (MFA) for the Administration GUI login is
currently not supported.

631115 Only 50000 records display in Adapter and Host Views.Example:Adapters -
Displayed: 50000 Total: 57500

795411 Not able to click the "In Use" number of Concurrent Licenses Widget.

870875 Address Group Object "In Use" button does not display accurate results.

Not all models of all network devices can be configured to perform Physical
MAC Address Filtering even though the Admin UI indicates that the
configuration can be set. Resolution: Hosts can be disabled by
implementing a Dead-end VLAN.

For Portal v2 configurations, web pages that are stored in the site directory
to be used for Scan Configurations will not be included when you do an
Export of the Portal v2 configuration. Resolution: The files in the site
directory are backed up with the Remote Backup feature, but otherwise
keep a copy of these files in a safe place.

Removing a device from the L2Wired Devices or L2 Wireless Devices
Group does not disable L2 (Hosts) Polling under the Polling tab in
Topology.

The "Set all hosts 'Risk State' to 'Safe'" button changes the status of all
hosts marked At-Risk to Safe. However, the status of the individual scans
for each host remain unchanged.

In a Layer 3 High Availability (HA) environment, configWizard must have a
DHCP scope defined. Running configWizard without a DHCP scope can
cause a failover.

On FortiNAC appliances with CentOS 7, duplicate log messages may
appear in dhcpd.log for each sub interface (eth1, eth1:1, eth1:2, etc).

System > Settings > Updates > Operating System will only record and
display dates of OS updates that are completed through the Administrative
UI. If Operating System updates are run via command line using the "yum"
tool, the update is not recorded. Resolution: Execute Operating System
Updates through the Administrative UI in order to maintain update history.

Only English versions of AV/AS and their corresponding definitions are
supported.

Anti-Virus product Iolo technologies SystemMechanic Professional is
currently not supported.
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Sophos UTM is currently not supported.

846822 FortiNAC failed the NMAP scan due to old IP reported from the arptool

860206 Polling threads get locked when communications are terminated
unexpectedly from the NCM

861201 Windows 11 Domain Check

854239 Radius CoA is not working as expected - ClassNotFoundException for
CambiumAP in 9.2 release

812908 /var/log/messages is not rotating generating large files and high disk usage
issues

855897 CLI config for Huawei Switch S5731-H48P4XC

856362 Upgrade from 8.x to 9.2.6 GA changes Conference account password

856192 FNAC FSSO does not send required groups to FGT.

852946 FortiNAC 9.2.6 SystemManagement menus gives HTTP 500 - Internal
server error

853007 Fortinac is sending big amount of API requests to Meraki API

853870 Kaspersky Endpoint Protection 11.10 is not supported by Fortinac

860996 Unable to read VLANs or L2 data for Huawei S6720-30C-EI-24S-AC

855891 FSSO failing to send to FGT for hosts with PA

842134 Blank section to Captive Portal page for mobile devices added after
upgrade.

850085 Juniper MIST integration needs to handle other domains than api.mist.com

859702 Enhance Palo Alto SSO REST API to allow for bulk messaging

833324 FortiNAC unexpectedly disabling Juniper EX interfaces when host is
deleted in "Host View"

840218 Cisco ASA firewall ports not showing on GUI

841781 FNAC as Local Radius does not send Radius CoA after NAC policy is
matched

852670 AP showing up as learned uplink not WAP Uplink

858138 FSSO Tags are not sent to Wired andWireless FortiGates after
reconnecting the LAN port on FGT1101E

770974 Event to Alarm mappings failing for Clear on Event criteria

809769 HTML is not supported when using "Guest Account Details" message type
template
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Ticket # Description (9.2.6.0451)

814476 HP J9776A 2530-24G Switch - Aggregation Port Issue

849140 NCMREST API ping of secondary in HA pod returns the wrong serial
number causing ping to fail

847630 Newly deployed NAC via OVA was incomplete requiring various manual
workarounds to get completed

846782 FortiNAC is unable to read roles and potentially other data from Aruba IAPs
due to a # symbol automatically added to the wireless network name.
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Device Support Considerations

Ticket # Description

730221 Stacked Meraki switches currently not supported. If required, contact sales
or support to submit a New Feature Request (NFR).

548902 Management of wired ports on Aerohive AP-150W controlled by
AerohiveNG is currently unsupported.

606729 The feature "Palo Alto VPN Integration" is currently not supported. It has
been determined not to be ready for customer production use for managing
remote user VPN connections through Palo Alto firewall.

679230 Aruba 9012-US currently not supported. If required, contact sales or
support to submit a New Feature Request (NFR).

829009 The Allowed VLAN list is not properly managed on Aruba CX switches.
When FortiNAC performs a VLAN change, only the new VLAN is set. The
previously configured Allowed VLAN is not removed. This causes the
Allowed VLANs list to grow over time.

836831 Layer 2 polling HPEWalljacks fails if special characters are found in the
devices mac-address table.

842181 FortiNAC does not support the custom RADIUS attribute Fortinet-Host-
Port-AVPair action=bounce-port for Change of Authorization (CoA) with
FortiSwitches.

843509 FortiNAC is unable to communicate with Dell x1026 switches.

846782 FortiNAC is unable to read roles and potentially other data from Aruba IAPs
due to a # symbol automatically added to the wireless network name.

7680531 Ubiquiti Gen2 Unifi switches (example: USW-16-POE) are currently not
supported. If required, contact sales or support to submit a New Feature
Request (NFR).

860546 L3 Polling currently not supported on ExtremeWireless Controllers

At this time, integration with Juniper MAG6610 VPN Gateway is not
supported. This includes Pulse Connect Secure ASA.

At this time, integration with Cisco 1852i Controller is not supported due to
the device's limited CLI and SNMP capability. For details, see related KB
article 189545.

At this time, Fortinet does not support wired port management for the Cisco
702W. The access point does not provide the management capabilities
required.

At this time, Fortinet is not able to support the Linksys LAPN600Wireless-
N600 Dual Band Access Point.
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Ticket # Description

Ports on Avaya Networks 4850GTS-PWR+ switches sometimes show "Not
Connected" even though the port is active. This is due to multiple ports on
the switch using the same MAC Address. This prevents NAC from correctly
discerning which are "Connected" versus "Not Connected". There is no
workaround.

Device models for Avaya 4800 switches (and potentially other related
models) only support SSH. Device models for Avaya Ethernet Routing
Switches only support Telnet. Contact Support if the alternate protocol is
required.
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Device Support

These changes have been made in FortiNAC Version 9.2. These are in addition to the device support added in
previous releases.

Version 9.2.6

Ticket # Vendor (9.2.6.0451)

805669 Extreme VSP-7400-48Y-8C (8.1.6.0)

814620 Cisco IOS Software, c6848x Software (c6848x-ADVENTERPRISEK9-M)
Palo Alto Networks PA-3200 series firewall
S5735-L24P4X-A1 Huawei Versatile Routing Platform Software
S5735-L24P4S-A1 Huawei Versatile Routing Platform Software
Extreme Networks Switch Engine (5420F-24P-4XE-SwitchEngine)
PowerConnect 7024, 5.1.18.1, VxWorks 6.6
Aruba JL658A 6300M 24SFP+ 4SFP56 Swch FL.10.09.1000
Datacenter Switch
Cisco IOS Software [Bengaluru],c8000be Software(X86_64_LINUX_IOSD-
UNIVERSALK9-M)

820169 Ruckus Wireless, Inc. ICX7850-48F, IronWare Version 08.0.95fT233

820969 HP A5120-24G SI Switch Software Version 5.20, Release 1513P13
S5720-52P-PWR-LI-AC Huawei Versatile Routing Platform Software VRP
(R) software,Version 5.170 (S5720 V200R011C10SPC600)
S5735-L8T4S-A1 Huawei Versatile Routing Platform Software VRP (R)
software,Version 5.170 (S5735 V200R020C10SPC500)
SG500X-24 24-Port Gigabit with 4-Port 10-Gigabit Stackable Managed
Switch

824676 Dell EMC Networking OS10 Enterprise.
Palo Alto Networks PA-400 series firewall
FGT-SG-SSL
U6-Lite 6.0.19.13671
Allied Telesis router/switch, Software (AlliedWare Plus) Version 5.5.1-2.4
CBS350-8FP-2G 8-Port Gigabit PoE Managed Switch

825863 Allied Telesis router/switch, Software (AlliedWare Plus) Version 5.4.9-0.2

827842 Alcatel-Lucent Enterprise OS6560-P48Z16 8.7.98.R03 GA, July 05, 2021.
Allied Telesis router/switch, Software (AlliedWare Plus) Version 5.5.1-2.4
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Ticket # Vendor (9.2.6.0451)

Cisco IOS Software, IE2000 Software (IE2000-UNIVERSALK9-M), Version
15.0(1)EY
Meraki MR44 Cloud Managed AP
Cisco IOS Software, cgr1000 Software (cgr1000-UNIVERSALK9-M),
Version 15.7(3)M1
S5731-S24T4X Huawei Versatile Routing Platform Software VRP (R)
software,Version 5.170 (S5731 V200R021C00SPC100)
PowerConnect 7024P, 5.1.18.1, VxWorks 6.6

830112 Dell EMC Networking N3224P-ON, 6.6.3.14, Linux 4.15.18-2ac8b3ec
Huawei AP5030DN Huawei Versatile Routing Platform Software VRP (R)
software,Version 5.170 (AP5030DN V200R010C00SPCd00) Dell EMC
Networking OS10 Enterprise.

833731 Huawei AR129CGVW-L Huawei Versatile Routing Platform Software VRP
S6720-56C-PWH-SI-AC Huawei Versatile Routing Platform Software VRP
Dell Networking N1524P
S5735-L24P4X-A1 Huawei Versatile Routing Platform Software VRP

Version 9.2.5

Ticket # Vendor (9.2.5.0443)

765569 DIGI cellular routers

789282 Extreme Campus Controller WLC

790006 Netgear S4300 and S3300 Switches

801676 HPE Comware Platform Software, Software Version 7.1.070, Release 6327

SG350XG-24F 24-Port 10G SFP+ Stackable Managed Switch
SG300-28SFP 28-Port Gigabit Managed SFP Switch
Linux PA-Mac-Ops-BCKPF-S 4.14.76-release-1.3.0 1 SMP
Aruba JL725A 6200F 24G CL4 4SFP+370W Swch ML.10.09.1000
Cisco IOS Software [Cupertino], ISR Software (ARMV8EL_LINUX_IOSD-
UNIVERSALK9-M), Version 17.7.1a
Cisco Sx220 Series Switch Software, Version 1.1.3.1
CBS350-24P-4G 24-Port Gigabit PoE Managed Switch
Firewall OCI Unimedsc
Palo Alto Networks VM-Series firewall
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Ticket # Vendor (9.2.5.0443)

Canton-Firewall

806646 S5735-L24T4X-A1 Huawei Versatile Routing Platform Software VRP (R)
FGT85F
S5731-H24T4XC Huawei Versatile Routing Platform Software
FGTVM641000C
S5732-H48UM2CC Huawei Versatile Routing Platform Software
FGT50A
JL581A Aruba 8320 48p
Juniper Networks, Inc. ex3400-48t Ethernet Switch

Version 9.2.4

Ticket # Vendor (9.2.4.0438)

796633 Fortigate
Cisco IOS Software, C1000 Software (C1000-UNIVERSALK9-M), Version
15.2(7)E4
Aruba R8N87A 6000 24G CL4 4SFP Swch PL.10.08.1010
Meraki MS355-48X2 Cloud Managed Switch
Dell EMC Networking OS10 Enterprise.S5224F-ON

Version 9.2.3

Ticket # Vendor (9.2.3.0435)

765568 Huawei AR550E router/switch

769085 MICROSENS G6 Micro-Switch
S5731-H48T4XC
FW_WLC

770214 S5300-52C-PWR-EI
S5731-S48P4X
Alcatel-Lucent Enterprise OS6465T-P12
Alcatel-Lucent Enterprise OS6465-P12
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Ticket # Vendor (9.2.3.0435)

FG_GRP9
brayhall-core-router
Meraki MR20 Cloud Managed AP

771979 SG250-08 8-Port Gigabit Smart Switch
S5700-10P-LI-AC
DC FortiGate Cluster

774429 Cisco NX-OS(tm) nxos.7.0.3.I4.1.bin, Software (nxos), Version 7.0(3)I4(1)
Dell Networking X1018P 1Gb PoE Switch
SG350-28 28-Port Gigabit Managed Switch
Ruijie 10G Ethernet Switch with PoE (S2910C-48GT2XS-HP-E)

777886 D-Link DGS-3130-30TS System - 24*10/100/1000M + 2*10GBase-T +
4*10G SFP+, 145.1.10.57
Fortigate
Cisco IOS Software, CDB Software (CDB-UNIVERSALK9-M)
Quidway S7706 Huawei Versatile Routing Platform Software
Cisco IOS Software, C880 Software (C880VOICE-UNIVERSALK9-M)
Fortinet
Cisco IOS Software, ir800 Software (ir800-UNIVERSALK9-M)

781634 S5700-52P-LI-AC Huawei Versatile Routing Platform

783982 S5720-12TP-LI-AC
S5720-36PC-EI-AC
S5720S-52P-SI-AC
S5700-10P-PWR-LI-AC

786422 ArubaOS (MODEL: 565)

787686 S5735-L48T4S-A1 Huawei Versatile Routing Platform Software VRP (R)
software
CBS350-48P-4X 48-Port Gigabit PoE Stackable Managed Switch with 10G
Uplinks
CBS350-48P-4G 48-Port Gigabit PoE Managed Switch
CBS350-8P-E-2G 8-Port Gigabit PoE Managed Switch
CBS350-24T-4X 24-Port Gigabit Stackable Managed Switch with 10G
Uplinks
Linux Lethe 2.6.18-92cpx86_64 1 SMPMon Oct 8 10:34:42 IDT 2018 x86_
64
Juniper Networks, Inc. srx380-poe-ac internet router, kernel JUNOS
20.4R3-S1.3
S5735-L8P4S-A1 Huawei Versatile Routing Platform Software VRP (R)
software
Fortigate fwf51E
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Ticket # Vendor (9.2.3.0435)

Quidway S9712 Huawei Versatile Routing Platform Software VRP (R)
Software
Brocade Communications Systems, Inc. FastIron SX 1600
CCB 1st Sessions Court FS108F
Meraki MR36H Cloud Managed AP

792686 Huawei AR129CGVW-L Huawei Versatile Routing Platform Software VRP
(R) software
Cisco NX-OS(tm) nxos.9.3.7.bin, Software (nxos)
Juniper Networks, Inc. ex4400-24p Ethernet Switch, kernel JUNOS
21.1R1.11
Aruba R8N85A 6000 48G CL4 4SFP Swch PL.10.09.1000
Aruba Instant On 1930 8G 2SFP Switch JL680A, InstantOn_1930_1.0.5.0
(139)
IE1000 Industrial Ethernet Switch, Version: 1.7.0#2018-05-
02T18:19:37+00:00

Version 9.2.2

Ticket # Vendor (9.2.2.0421)

760460 FortiSwitch
Dell EMC Networking N1124T-ON
Alcatel-Lucent Enterprise OS6560-P24X4
Alcatel-Lucent OS6450-U24
ExtremeXOS (X620-16x)
ExtremeXOS (X450G2-24p-10G4)
Aruba R0M68A 2930M-24SR-PoE-Class6 Switch
Aruba JL727A 6200F 48G CL4 4SFP+370W Switch
Aruba JL675A 6100 48G CL4 4SFP+
PLANET, IGS-10020HPT, IE L2+ Managed Switch

761980 Alcatel-Lucent Enterprise OS6860E-P48
Alcatel-Lucent Enterprise OS6560-24X4
Alcatel-Lucent Enterprise OS6560-P48Z16
Alcatel-Lucent Enterprise OS6560-P48X4
CHS_Fortigate_VM04

763316 VSP-4900-12MXU-12XE

765550 Alcatel-Lucent Enterprise OS6560-48X4
Enterasys Networks, Inc. A4H124-24
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Ticket # Vendor (9.2.2.0421)

24-port 10/100 PoE Switch w/4 gigabit ports S5735-L48P4X-A1
Huawei Versatile Routing Platform
Huawei AR550E Huawei Versatile Routing Platform

766493 Dell PowerConnect 5548P

767310 HP 1910-24 Switch
Allied Telesis router/switch, AW+ v5.4.6-1.5

Version 9.2.1

Ticket # Description (9.2.1.0415)

749162 FortiSwitch-108F-POE

752957 Aruba Instant On 1930 48G 4SFP/SFP+ Switch JL685A
HPE 5510 24G PoE+ 4SFP+ HI 1-slot Switch
JH147AWS6-DGS-1210-28/F1 6.10.007
Dell Networking N1524
Palo Alto Networks PA-3200 series firewall
HP 1820-48G-PoE+ (370W) Switch J9984A
Hirschmann MICE Switch Power
Hirschmann Rail Switch Power Enhanced
USIDC-FWL001
swich standalone
NetVanta 1534P
AOS-W (MODEL: OAW-4030)

756556 Enterasys Networks, Inc. Bonded SSA Chassis Rev 08.11.04.0005

754988 FSW_248E_POE
FSW_148F
FSW_148F_POE
FSW_148F_FPOE
FSW_124F
FSW_108F
FSW_108F_POE
FSW_108F_FPOE
FSW_1024E
FSW_T1024E
FSW_124F_POE
FSW_124F_FPOE
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Version 9.2.0

Ticket # Vendor (9.2.0.0409)

688048 ApresiaNP2000-24T4X
ApresiaNP2000-24T4X-PoE
ApresiaNP2000-48T4X
ApresiaNP2000-48T4X-PoE
Apresia13200-28GT
Apresia13200-52GT
Apresia5428GT
Apresia3424GT-SS
ApresiaLightGM110GT-PoE
ApresiaLightGM110GT-SS
ApresiaLightGM118GT-SS
ApresiaLightGM124GT-PoE
ApresiaLightGM124GT-SS
ApresiaLightGM152GT

706225 Ruijie XS-S1960

712593 Huawei S2700-9TP-PWR-EI
Meraki MS125-48FP Cloud Managed PoE Switch
Huawei S5735-S48T4X
Extreme Networks, Inc. A2H124-24P
Cisco Controller
ArubaOSW-AP103

714422 Planet IGS-10020PT

720989 Cisco IOS Software, C1000 Software (C1000-UNIVERSALK9-M), Version
15.2(7)E2
Huawei S5735-L24P4S-A
Huawei S5735-L48P4X-A
SG350-28SFP 28-Port Gigabit SFP Managed Switch
ExtremeXOS X440G2-24x-10G4
ExtremeXOS X440-24x-10G
ExtremeXOS X440-L2-24t
ExtremeXOS X440-24x
ExtremeXOS X620-8t-2x
Industrial 6-P GbE RJ45 + 2-P GbE SFP L2 Plus Managed UPoE Switch
Dell EMC Networking N3132PX-ON
Dell EMC Networking S3148P
Dell EMC Networking OS10 Enterprise
Dell Networking OS Series: PE-FN-410S-IOM
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Ticket # Vendor (9.2.0.0409)

Dell EMC Networking OS10 Enterprise
Aruba JL660A 6300M 24SR5 CL6 PoE 4SFP56
Meraki MS390-24UX L3 Stck Cld-Mngd 24-port mGbE UPoE switch
Meraki MS390-48UX2 L3 Stck Cld-Mngd 48-port 5GbE UPoE switch
Fortinet FortiGate
Ruckus Wireless, Inc. ICX7150-24-POE, SPR08090b
50-Port Gigabit PoE Smart Switch
Viptela SNMP agent

721009 Added missing property for Viptela devices

724820 Ruckus Wireless, Inc. ICX7850-48FS
Dell EMC Networking OS10 Enterprise, System Type: S5212F-ON
Ruckus Wireless, Inc. ICX7650-48F
HVC-Budel-FW01
Brocade Communications Systems, Inc. ICX7250-24, labeled as
SPS08030
Brocade Communications Systems, Inc. FWS648G-POE, labeled as
FWSL07400d 1
Ruckus Wireless, Inc. ICX7150-C08-POE, labeled as SPS08091
Dell Networking OS, Series: MXL-10/40GbE
Cisco IOS Software, C2960CX

730834 Foundry Networks FWSX424+2XG
Ruckus Wireless, Inc. Stacking System ICX7550-24F
Huawei S5720-52X-LI-AC
HP Series Router A-MSR30-10
H3C Series Router MSR30-10
Alcatel-Lucent Enterprise OS6350-P24
Alcatel-Lucent Enterprise OS6350-48
LGS308P 8-Port Gigabit PoE+ Smart Switch
HPE MSR3012
Meraki MR44 Cloud Managed AP
Dell S4112T-ON
Aruba JL676A 6100 48G 4SFP+
Aruba JL679A 6100 12G CL4 2SFP+
Dell S5048F-ON
Brocade ICX7150-48-POE
Brocade ICX7150-48-POEF
HPE OfficeConnect 1950-24G-2SFP+-2XGT
Huawei S5735-S48P4X Cisco NX-OS(tm) n5000

FortiNAC 9.2.6 Release Notes 53
Fortinet Inc.



Device Support

Ticket # Vendor (9.2.0.0409)

734133 Pnetworks switch

735445 Huawei Quidway S3352P-EI
Huawei Quidway S9306

743833 Cisco Nexus(Cisco NX-OS(tm) nxos.9.3.5.bin)
Cisco Nexus (Cisco NX-OS(tm) nxos.7.0.3.I7.9.bin)

745113 Dell EMC Networking OS
S5730-68C-PWR-SI-AC Huawei Versatile Routing Platform Software VRP
S5730-48C-PWR-SI-ACHuawei Versatile Routing Platform Software VRP
SX350X-52 52-Port 10GBase-T Stackable Managed Switch
PLANET IGSW-24040T Managed Switch
Cisco IOS Software, CSR1000V Software (X86_64_LINUX_IOSD-
UNIVERSALK9-M)
Cisco IOS Software, C3560E Software (C3560E-UNIVERSALK9-M)
Dell EMC Networking N2224PX-ON, 6.6.1.1, Linux 4.4.170-b055baf1
Dell EMC Networking N3024EF-ON, 6.6.3.36, Linux 4.14.138, v1.0.5
Dell EMC Networking N2248PX-ON, 6.6.3.10, Linux 4.15.18-2ac8b3ec
Dell EMC Networking N3248P-ON, 6.6.3.14, Linux 4.15.18-2ac8b3ec
Dell EMC Networking N1108EP-ON, 6.6.3.10, Linux 4.14.138
FortiGate
Aruba JL677A 6100 24G CL4 4SFP+ Swch PL.10.06.0001
Juniper Networks, Inc. ex3400-24t Ethernet Switch
HPE 1950 48G 2SFP+ 2XGT Switch
Meraki MR53E Cloud Managed AP
Linux cep-gate 3.10.0-957.21.3cpx86_64 1 SMP
Aruba JL659A 6300M 48SR5 CL6 PoE 4SFP56 Swch FL.10.08.0001

689049 Dell Switch S4128T (DellSwitchOS10)
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System Update Settings

Use the following System Update Settings when upgrading through the Administrative UI:

Field Definition

Host Set to fnac-updates.fortinet.net

Auto-Definition Directory Keep the current value.

Product Distribution
Directory

Systems running version 8.3.x and higher: Set to Version_9_2

Agent Distribution
Directory

Keep the current value.

User Set to updates (in lowercase)

Password Keep the current value.

Protocol Set to desired protocol (FTP, PFTP, HTTP, HTTPS)
Note: SFTP has been deprecated and connections will fail using this option.
SFTP will be removed from the drop down menu in a later release.
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Numbering Conventions

Fortinet is using the following version number format:

<First Number>.<Second Number>.<Third Number>.<Fourth Number>

Example: 8.0.6.15

l First Number = major version
l Second Number = minor version
l Third Number = maintenance version
l Fourth Number = build version

l Release Notes pertain to a certain version of the product. Release Notes are revised as needed. The Rev
letter increments accordingly. For example, updating the Release Notes from Rev C to Rev D indicates
changes in the Release notes only -- no changes were made to the product.

l The next number represents the version in which a Known Anomaly was added to the release notes (for
example, V8.0).
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